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ВВЕДЕНИЕ

О программе

Пакет FrameMaker присутствует на рынке настольных издательских си-
стем уже более 20 лет. За это время он получил устойчивую репутацию луч-
шего программного средства для подготовки сложных многостраничных пу-
бликаций. Объективная статистика показывает, что большая часть таких
изданий, как технические монографии, учебники по естественно-научным
дисциплинам, словари, энциклопедии, справочники и т. д., готовятся к печати
в среде FrameMaker. Какие же особенности сделали пакет лидером в этом сек-
торе издательского бизнеса? 

FrameMaker обладает очень устойчивым движком. Много лет интенсив-
ной эксплуатации позволили выявить и устранить большую часть програм-
мных ошибок. Чистота кода сочетается с высокой реактивностью пакета.
Сложные директивы форматирования, требующие масштабной переверстки
документа, FrameMaker отрабатывает «на лету», позволяя верстальщику опе-
ративно оценить принятое решение. 

В состав пакета включены специальные средства разработки объемных
публикаций. Аппарат создания автоматических нумераций, инструменты для
работы с большими таблицами, редактор математических формул, команды
генерации порожденных файлов и множество других технических средств по-
зволяют сверстать макет любой сложности. 

Программа ориентирована на единообразное форматирование и воспроиз-
водство повторяемых оформительских решений. Это достигается продуман-
ным применением шаблонов и стилей. Шаблоны FrameMaker представляют
собой контейнеры оформительских данных. Информационной емкостью они
намного превосходят шаблоны других настольных издательских систем и спо-
собны хранить большую часть оформительских атрибутов публикации. Ша-
блоны FrameMaker позволяют накапливать оформительские данные и обмени-
ваться ими между различными проектами. Это мощное средство
автоматической верстки, которое существенно упрощает переиздание публи-
каций.

FrameMaker – это одна из немногих программ, полноценно поддерживаю-
щих работу с единым источником (single sourcing). Единым источником назы-
вают такую технологию разработки, которая наделяет документ способно-
стью существовать в различных информационных средах: в печатной форме,
на диске, в корпоративной локальной сети, на сайте во Всемирной сети. Эта
возможность реализована в пакете очень экономными средствами – главным
образом при помощи условных стилей и конверторов в основные печатные и
электронные форматы (HTML, XML, PDF и др.). Условные стили позволяют
менять состав и вид документа, а конверторы обеспечивают вывод версий на
различные носители. 

Существуют издания, с которыми плохо справляются традиционные тех-
нологии допечатной подготовки, даже в их современной компьютеризован-
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ной версии. В качестве примера можно привести документацию на любой
масштабный технический проект (самолет, автомобиль, станок и прочее). Это
большой массив текстов, рисунков, таблиц, разработка которого ведется ав-
торским коллективом и который претерпевает интенсивные изменения в тече-
ние длительного периода своего существования. Структурное проектирование
– это современный подход к разработке сложных документов, основанный на
внедрении в исходный текст служебной разметки. Элементы разметки, назы-
ваемые дескрипторами, описывают структурные характеристики фрагментов,
разделяя их содержание и оформление. Разметка документа позволяет эффек-
тивно решить многие трудные проблемы создания и сопровождения объемной
технической документации. 

FrameMaker – одна из немногих программных платформ, которые объеди-
няют преимущества визуального и структурного подходов к разработке. Пакет
поддерживает создание разметки на языках XML в стандартах DITA и
S1000D. Он способен открывать и редактировать XML-файлы, созданные дру-
гими программными приложениями. 

Структурный подход к проектированию документов принципиально отли-
чается от классической техники верстальщика. Обсуждение этой темы требу-
ет изложения теории языков разметки и большого объема другого вспомога-
тельного материала. Это предмет отдельного издания, поэтому в книге
рассматриваются возможности  «неструктурной версии» FrameMaker.

У первых изданий программы были некоторые проблемы с обработкой
текстов на русском языке. Несмотря на это, многие верстальщики и техниче-
ские писатели работали во FrameMaker, «сводя баланс недостатков и преиму-
ществ с положительным знаком». Последняя, десятая версия программы, вы-
шедшая в самом начале 2011 года, полноценно поддерживает русский язык.
Это распространяется на все ресурсы пакета: от простейших команд, приме-
ром которых служит проверка орфографии на лету, до сложных алгоритмиче-
ских операций, подобных сборке предметного указателя. 

Основные соглашения

К сожалению, пока не существует локализованной версии пакета, поэто-
му в книге приводятся английские названия команд FrameMaker. Директивы
операционной системы и названия общесистемных интерфейсных элементов
даются по русскоязычному варианту Microsoft Windows 7.

Составные команды, требующие обращения к нескольким разделам си-
стемы меню, записаны в виде цепочек вида File => Import => Formats (Файл
 Импорт  Форматы). 

Все команды, зарезервированные слова (названия системных файлов,
имена стандартных шаблонов и прочее) и клавиатурные ускорители команд
оформлены в тексте рубленым шрифтом Arial. 

Подобно любой профессиональной программе, FrameMaker располагает
большим количеством клавиатурных ускорителей. Трудно представить себе
производительную работу над сложным проектом без их интенсивного ис-
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пользования. В книге приводятся клавиатурные эквиваленты самых востребо-
ванных программных ресурсов. Комбинации, требующие одновременного на-
жатия клавиш, записываются со знаком «плюс», например Ctrl+Z (эквивалент
команды отмены). Во FrameMaker существует множество непривычных для
пользователя Windows клавиатурных сочетаний, называмых Esc-последова-
тельностями. Они всегда начинаются с нажатия Esc и вводятся последователь-
но. Записываются такие эквиваленты через пробел, например Esc b p (коман-
да перевода текстового в начало следующего абзаца). 

Все Esc-последовательности должны набираться только в английском
регистре. Использование для этого литер кириллической раскладки может
привести к ошибке. 

Вычислительные ресурсы

Программа предъявляет весьма скромные по современным меркам требо-
вания к конфигурации технических средств и ресурсам вычислительной си-
стемы. Для работы на платформе Windows фирма Adobe рекомендует иметь:

• процессор Intel Pentium IV и выше или аналогичный по мощности x86-
процессор других производителей;

• операционная система: Windows XP с пакетом обновлений Service Pack
3, Windows Vista с пакетом обновлений Service Pack 2 или Windows 7;

• 512  Мб оперативной памяти (рекомендуется 1 Гб);
• 1,7  Гб свободного пространства на жестком диске;
• привод DVD-ROM;
• минимальное разрешение экрана 1024×768 и видеокарта с поддержкой

16-битного цвета.
С автором можно связаться по адресу arcad@land.ru.
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1. ОСНОВЫ РАБОТЫ С ПРОГРАММОЙ

1.1. Интерфейс

Программа FrameMaker создавалась в те далекие времена, когда не было
ясных представлений о технике управления сложными программами. Интер-
фейсные шероховатости, которыми отличались все ранние издания програм-
мы, полностью исправлены в ее последних версиях. Программа получила сов-
ременный и гибкий интерфейс пользователя, основанный на прошедших
испытание временем приемах взаимодействия человека и компьютера. Глав-
ное в новом облике программы – это настраиваемые панели, которые можно
объединять в группы по признаку функционального подобия или частоты ис-
пользования. Многочисленные настройки разрешают пользователю создавать
и сохранять удобную конфигурацию рабочей среды с упорядоченным распо-
ложением необходимых панелей и окон.

Рис. 1.1. Окно программы
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После запуска программы и открытия документа на экран будет выведено
окно, примерный вид которого показан на рис. 1.1. Рассмотрим его основные
компоненты:

1 – главное меню программы;
2 – главная инструментальная панель;
3 – закладка активного документа;
4 – закладка открытого документа;
5 – окно активного документа;
6 – элементы управления рабочей средой;
7 – группа закрепленных панелей;
8 – закладки управляющих пультов;
9 – строка состояния;

10 – плавающая панель.

1.1.1. Главное меню

Главное меню (main menu) является основным диспетчерским пультом
программы (см. рис. 1.1, номер 1). Оно открывает доступ к средствам управ-
ления (командам, панелям, диалоговым блокам), с помощью которых выпол-
няется вся работа по созданию и форматированию документа и настройка
программы.

Каждый раздел главного меню объединяет группу функционально близ-
ких команд, доступ к которым возможен через систему вложенных меню.
Приведем краткое описание главных разделов:

• File (Файл) – объединяет основные файловые команды, команды печа-
ти, вызов вспомогательных утилит и настройки программы;

• Edit (Правка) – содержит команды отмены и повторения действий поль-
зователя, команды для работы с буфером обмена и запуск процедур по-
иска и проверки орфографии;

• Format (Формат) – включает в себя команды форматирования символов
и абзацев, а также средства планировки и структурирования страниц;

• View (Вид) – в этот раздел входят средства управления видами, режи-
мами отображения экрана и команды вызова инструментальных пане-
лей и диалоговых блоков;

• Special (Специальный) – содержит набор средств для создания слож-
ных документов: команды гипертекстовой разметки, средства для
вставки маркеров и переменных, команды генерации порожденных
файлов (оглавлений и списков);

• Graphics (Графика) – объединяет разнообразные команды, предназна-
ченные для работы с графикой и вызова внешних графических редак-
торов;

• Table (Таблица) – в раздел входят команды для создания, редактирова-
ния и форматирования таблиц;

• CMS – содержит команды, предназначенные для взаимодействия с си-
стемами управления контентом (content management system);
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• Window (Окно) – включает в себя стандартные команды управления
многооконным интерфейсом;

• Help (Помощь) – объединяет различные средства поддержки пользова-
теля: интерактивную подсказку, запуск процедуры регистрации, поиск
и загрузку обновлений и др.

Система меню программы построена по иерархическому принципу. От-
дельные пункты меню могут открывать доступ к разделам следующего уров-
ня, которые, в свою очередь, могут содержать еще более глубоко вложенные
подменю. Например, если щелкнуть по разделу главного меню Edit, а затем
выбрать пункт Copy Special, то раскроется выпадающее подменю, представ-
ленное на рис. 1.2.

Рис. 1.2. Пример вложенного меню

В программе приняты стандартные правила работы с системой меню. На-
помним их. Пункты меню, которые отмечены с правой стороны черным тре-
угольником, содержат вложенные подменю. Подменю раскрывается, если под-
вести курсор к его названию. Пункты меню без треугольных пометок
представляют собой команды, которые выполняются по щелчку мыши. Ко-
манды, после имени которых стоит многоточие, открывают окна диалога. Это
значит, что для выполнения такой команды требуется задать в специальном
диалоговом окне какие-то дополнительные параметры. В примере, показан-
ном  на рис. 1.2, такой командой является Spelling Checker (Проверка орфогра-
фии). Названия недоступных разделов и команд меню – серого цвета. Самые
востребованные команды могут запускаться на выполнение при помощи соче-
тания горячих клавиш. Такие клавиатурные комбинации приводятся после на-
звания команды. 

Если слева от названия раздела меню стоит специальный
маркер (галочка), это значит, что данная команда уже выполнена. Такие дирек-
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тивы действуют как двоичные переключатели. Выполнение команды включа-
ет какой-то режим работы программы, повторное выполнение отменяет его.
Особенно много подобных средств в разделе главного меню View. 

FrameMaker предлагает несколько способов выполнения команд:
• навести курсор на пункт меню с названием команды и щелкнуть левой

кнопкой мыши;
• навести курсор на пункт меню с названием команды и нажать на клави-

шу Enter;
• выполнить команду при помощи клавиш-акселераторов (только в ла-

тинской раскладке). Для этого нажать клавишу Alt, после чего в назва-
ниях разделов главного меню будет подчеркнута одна буква. Это
обозначение так называемой клавиши-акселератора. Команда запуска-
ется последовательным нажатием клавиш-акселераторов, соответству-
ющих ее положению в иерархии вложенных меню. Например, чтобы
выполнить команду Spelling Checker (Поверка орфографии) (см.
рис. 1.2), надо нажать Alt,  а затем последовательность латинских букв
e, l (Edit => Spelling Checker); 

• некоторые команды можно запустить при помощи комбинации «горя-
чих клавиш». Такие клавиатурные наборы указываются с правой сто-
роны от названия команды. Из изображенных на рис. 1.2 такими
командами являются Paste (Ctrl+V), Select All in Flow (Ctrl+A) и др.;

• кроме стандартных для Windows-приложений  комбинаций с использо-
ванием управляющих клавиш Ctrl, Alt, Shift многие команды
FrameMaker можно выполнить при помощи так называемых Esc-после-
довательностей. Например, для вывода на экран панели для вставки
маркеров надо нажать клавишу Esc, а затем s m. Перечень многочи-
сленных Esc-последовательностей, доступных в программе, приводит-
ся в приложении (только в латинской раскладке);

• запуск команд при помощи кнопок инструментальных панелей.
Количество пунктов и подпунктов главного меню можно менять. Команда

View => Menus => Quick (Вид => Меню => Короткое) сокращает количество
разделов, оставляя только самые нужные команды. Команда View => Menus =>
Complete (Вид => Меню => Полное) восстанавливает главное меню в полном
виде.

1.1.2. Главная инструментальная панель

Главная инструментальная панель расположена под заголовочной строкой
и объединяет кнопки вызова наиболее востребованных команд программы
(рис. 1.3). В документации на пакет и в интерактивной справке она именуется
Quick Access Bar, что дословно можно перевести как «панель быстрого досту-
па». Но подобный элемент интерфейса, облегчающий использование основ-
ных ресурсов и средств, содержится чуть ли не в каждом Windows-приложе-
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нии и в большинстве случаев называется главной панелью. Будем следовать
этой традиции. 

Рис. 1.3. Главная панель

Рассмотрим содержимое  главной панели:  
1 – Help (Помощь). Вызов интерактивной подсказки;
2 – New (Новый). Создание нового документа;
3 – Open (Открыть). Открытие документа;
4 – Save (Сохранить). Сохранение документа;
5 – Import (Импортировать). Импорт внешнего графического или тексто-

вого файла;
6 – Print (Печать). Вызов настроек печати и вывод на печать;
7 – Toggle View Only (Переключить в режим просмотра). Переводит экран

в режим просмотра. В этом режиме недоступны средства редактирова-
ния документа, который разрешается только пролистывать;

8 – Clear (Очистить). Удаляет помеченный фрагмент документа (текст, ри-
сунок, таблицу и прочее);

9 – Cut (Вырезать). Переносит помеченный фрагмент в буфер обмена;
10 – Copy (Копировать). Копирует помеченный фрагмент в буфер обмена;
11 – Paste (Вставить). Вставляет содержимое буфера обмена в документ;
12 – Undo (Отмена). Отмена пользовательских операций;
13 – Redo (Повтор). Повторение отмененных пользовательских операций;
14 – Repeat (Повторное исполнение). Повторное исполнение последней

операции пользователя;
15 – History (История). Вызов панели History;
16 – Character Catalog (Каталог символьных стилей). Вывод на экран ката-

лога символьных стилей;
17 – Paragraph Catalog (Каталог абзацных стилей). Вывод на экран катало-

га абзацных стилей;
18 – Table Catalog (Каталог табличных стилей). Вывод на экран каталога

табличных стилей;
19 – Find/Change (Найти/Заменить). Запускает команду поиска и замены;
20 – Find Next (Продолжить поиск). Команда продолжения поиска;
21 – Spelling Checker (Проверка орфографии). Запускает команду проверки

орфографии;
22 – Anchored Frame (Прикрепленный блок). Вставка прикрепленного бло-

ка; 
23 – Footnote (Сноска). Вставка сноски;
24 – Insert Table (Вставка таблицы). Запускает команду создания таблицы;
25 – Symbols (Символы). Выводит на экран меню для вставки специальных

символов;
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26 – Preview Filter by Attribute (Предварительный просмотр фильтрации
атрибутов). 

1.1.3. Инструментальная панель символьного форматирования

Носителями шрифтовых оформительских атрибутов в программе могут
быть отдельные символы, символьные цепочки и абзацы. Символы и цепочки
определяют сами себя, тогда как абзацем или параграфом называется тексто-
вый фрагмент, ограниченный специальным непечатаемым символом (конец
абзаца), который можно увидеть только на экране монитора в специальном ре-
жиме отображения документа.    

Инструментальная панель Text Formatting (Символьное форматирование),
показанная на рис. 1.4, объединяет кнопки вызова наиболее употребительных
средств форматирования произвольных текстовых фрагментов. Она выводит-
ся на экран командой главного меню View => Toolbars => Text Formatting
(Вид  Инструментальные панели => Символьное форматирование). 

Рис. 1.4. Панель Text Formatting

Рассмотрим содержимое этой панели:
1 – Plain (Обычный). Задает стандартное начертание символов;
2 – Bold (Полужирный). Задает полужирное начертание символов;
3 – Italic (Курсивный). Задает курсивное начертание символов;
4 – Underline (Подчеркнутый). Задает подчеркнутое начертание символов;
5 – Increase Font Size (Уменьшить размер шрифта). Уменьшает размер

шрифта помеченных символов;
6 – Decrease Font Size (Увеличить размер шрифта). Увеличивает размер

шрифта помеченных символов;
7 – Lowercase (Строчные). Превращает все символы помеченного тексто-

вого фрагмента в строчные;
8 – Initial Caps (Первая прописная). Первые буквы всех помеченных слов

становятся прописными, остальные буквы – строчными;
9 – Uppercase (Прописные). Все символы помеченного фрагмента стано-

вятся прописными;
10 – Font (Шрифт). Служит для выбора шрифта;
11 – Size (Размер). Служит для выбора размера.

1.1.4. Инструментальная панель абзацного форматирования

Инструментальная панель Paragraph Formatting (Абзацное форматирова-
ние), показанная на рис. 1.5, служит для вызова самых актуальных команд
форматирования параграфов. Для вывода этой панели на экран можно вос-
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пользоваться командой View => Toolbars => Paragraph Formatting (Вид  Ин-
струментальные панели => Абзацное форматирование).

Рис. 1.5. Панель Paragraph Formatting

Рассмотрим состав этой панели:
1 – Left Tab (Левый табулятор). Выбирает левый табулятор ;
2 – Center Tab (Центральный табулятор). Выбирает центральный табуля-

тор;
3 – Right Tab (Правый табулятор). Выбирает правый табулятор;
4 – Decimal Tab (Десятичный табулятор). Выбирает десятичный табуля-

тор;
5 – Left (Левый). Задает выравнивание по левому краю (левая выключка);
6 – Right (Правый). Задает выравнивание по правому краю;
7 – Center (Центральный). Задает выравнивание по центру;
8 – Justify (По ширине). Задает выравнивание по ширине;
9 – Single (Одинарный). Устанавливает одинарный межстрочный интер-

вал;
10 – 1.5 (Полуторный). Устанавливает полуторный межстрочный интервал;
11 – Double (Двойной). Устанавливает двойной межстрочный интервал;
12 – Custom (Заказной). Вызывает диалоговый блок для выбора нестандар-

тного значения межстрочного интервала;
13 – Space Between (Расстояние между). Служит для выбора расстояния

между смежными абзацами;
14 – Paragraph Formats (Форматы параграфов). Предназначен для выбора

абзацного стиля.
Обе инструментальные панели символьного и абзацного форматирования

обладают свойством контекстной чувствительности. Они показывают атрибу-
ты форматирования помеченного текстового фрагмента: строки символов или
абзаца. 

1.1.5. Окно документа

Каждый документ в программе отображается в отдельном окне (рис. 1.6).
Рабочее окно документа – это интерфейсный элемент, отвечающий большин-
ству привычных соглашений операционной системы Windows. Его обязатель-
ными атрибутами являются заголовочная строка, строка состояния и линейки
прокрутки (вертикальная и горизонтальная). 

В заголовочной строке (см. рис. 1.6, 3) выводится имя загруженного фай-
ла и расположены три стандартные кнопки, управляющие размером окна.
Строка состояния (см. рис. 1.6, 6) выполняет очень важные функции. Она
представляет собой информационное табло, на котором отображается спра-
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вочная и управляющая информация о редактируемом документе. Кроме того,
она содержит средства масштабирования документа и навигации по страни-
цам. 

При работе с большим документом часто приходится перемещаться меж-
ду его фрагментами, которые не попадают в зону видимости окна. Такой пере-
ход называется прокруткой изображения, скроллингом или панорамировани-
ем. Полосы прокрутки – стандартное средство перемещения по большому
документу (см. рис. 1.6, 7). Во FrameMaker техника работы с ними ничем не
отличается от других приложений Windows. 

Следует отметить: полосы прокрутки – это простое, но не самое эффек-
тивное средство навигации. Программа предоставляет пользователю несколь-
ко дополнительных возможностей перемещения с использованием специаль-
ных команд и клавиатурных ускорителей. 

Рис. 1.6. Окно документа в связанном (a) и свободном (b) состояниях

Содержимое документа располагается в пределах текстовых и графиче-
ских блоков, границы которых изображаются пунктиром (см. рис. 1.6, 5). Тек-
стовый блок представляет собой контейнер, который хранит основной контент
страницы: текст, графические вставки, маркеры, управляющие спецсимволы и
др. Он задает полосу набора и решающим образом влияет на параметры печат-
ного оттиска.

Размерные линейки задают привязку к единой системе координат, служат
для измерения объектов и задают положение табуляторов и горизонтальных
отступов (см. рис. 1.6, 4).




